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MOVE2018.1 SOFTWARE AND SUPPORTING DOCUMENTATION

Move2018.1 Software

Move2018.1 Software Installers for Move and Knowledge Base

Move2018.1/Windows64 Installers for Windows (64-bit)

Move2018.1/Linux64 Archive for Linux (64-bit)

License Manager Software

LicenseManager/FLEXnet11.14/Windows64 License Manager for Windows (64-bit)

LicenseManager/FLEXnet11.14/Linux64 License Manager for Linux (64-bit)

LicenseManager/FLEXnet11.14/docs License Manager Documentation

Move Link for Petrel Software Installers

MoveLinkforPetrel/Petrel 2015 MSI and PIP Installers for Petrel 2015

MoveLinkforPetrel/Petrel 2016 MSI and PIP Installers for Petrel 2016

MoveLinkforPetrel/Petrel 2017 MSI and PIP Installers for Petrel 2017

Move2018.1 Release Documentation

The following documents, Tutorials, and Knowledge Base are provided with Move2018.1 and can also be
found in the Client section of our website (www.mve.com/clients).

l Move2018.1 Release Notes PDF
l Move2018.1 Installation Guide PDF
l Move2018.1 Licensing Guide PDF
l Move2018.1 Tutorials
l Move2018.1 Tutorial Data Files

In Move2018.1 we are on the third release of the Move Knowledge Base. The Knowledge Base resource
contains all the Move Help Pages, Tutorials, Monthly Features and release documentation presented in a
single, offline, searchable entity, independent of Move.

l Move2018.1 Knowledge Base

2018.1.1 Installation Guide
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SYSTEM REQUIREMENTS

Operating Systems

Please check to ensure you have at least the minimum specification before installing:

Windows
64-bit versions of Windows 7 or Windows 8 or Windows 10

Windows requires .NET Framework 4.6. or higher.

Linux Linux Red Hat Enterprise 6 or 7 (64-bit only).

Move may run on other distributions of Linux however these have not been tested. For optimal video
performance with OpenGL when using an NVIDIA video card under Linux, it is recommended that you use the
accelerated drivers provided byNVIDIA on their website www.nvidia.com.

Using Move in a virtualmachine (with Mac OSX as guest) is not supported.

Graphics Card

Move is a graphics intensive application and takes advantage ofmodern hardware GPUs in order to speed up
3D rendering. The more memory on the graphics card the better Move will handle larger 3D/2D Seismic files,
DEMs and Image overlays.

Graphics Card requirements (Notebook or Workstation)

l Minimumof 4GB of RAM
l Graphics card drivers fully up to date
l Run pixel shader 2 or later
l Be OpenGL compatible

Workstation Graphics Card Recommended:

l NVIDIA with 4GB RAM e.g. Quadro M4000, MK22000, K1200

Workstation Graphics Card Preferred

l NVIDIA with 8GB RAM e.g. Quadro P/M6000, P/M5000

Notebook Graphics Card Recommended

l NVIDIA with 2GB RAM eg. Quadro M1000M, M600M

Notebook Graphics Card Preferred

l NVIDIA with 4GB RAM e.g. Quadro M5500, M5000M, M4000M, M3000M, M2000M
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Hardware

The following list is provided as a general guide only. If your system configuration is different and you are
unsure of its capability then please email us: support@mve.comwith your system details for further
information. The hardware requirements greatly depend on the size of data sets you are using. If you are
working with large data sets and utilising Move applications simultaneously then we would strongly suggest
the following recommendations.

Workstation/Desktop

For example, Dell Precision 5000/7000

Specification Recommended Minimum Recommended Ideal

CPU
Intel i5 quad-core  Intel i7 /Xeon E5

4C/6C/8C/12C

Memory 8 GB 16-64 GB+

Laptop/Notebook

For example Dell Precision 5000 15”, 7000 17”, 7000 17”

Specification Recommended Minimum Recommended Ideal

CPU Intel i5 quad-core Intel i7 quad-core

Memory 8 GB 8-32 GB+

Screen/Monitor

l Minimum screen resolution is a single monitor/screen with 1920 x 1080 pixels (full HD 1080p)
l Move is a graphics intensive application supporting multiple simultaneous views of your data model,
and we recommend as much screen space as you can afford in order to maximise your experience and
attention to detail.

l Move will support dualmonitors which are recommended at 30” in size and above.

2018.1.1 Installation Guide
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INSTALLING MOVE

Windows and Linux have different installation instructions. Please refer to the appropriate section below.

Installing on Windows

It is recommend that you should be a power/administrator user onWindows to install or with UAC elevated to
administrator to install on Windows 7.

Move2018.1 requires .NET Framework 4.6.

l Desktop - .NET Framework 4.6 comes pre-installed with Windows 10 first version and all versions
thereafter. Can be downloaded forWindows 8.1, 8 and 7.

l Server - .NET Framework 4.6 comes pre-installed with Windows Server 2016 and all versions there-
after. Can be downloaded forWindows Server 2012 R2, 2012, 2008 R2 SP1, 2008 SP2.

To begin the installation process youmust browse to the installer file, for example:

:\Move2018.1\Windows64\move_2018.1.1_windows_64-bit.exe

License Agreement

To continue with installation please accept the terms of the agreement and clickNext.

Installation Folder

Select the folder in which you wish to install Move. Youmay select your own location by clicking Choose or by
typing the explicit location in the input box. By default it is:

C:\Program Files\Midland Valley\Move2018.1
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License Manager Components

The Move installer will install a FLEXnet License ManagerWindows Service as part of the post-install process.
This service MUST be installed. If you wish to run Move from a network drive location, or copy/script a custom
Move setup, then please contact Midland Valley for further instructions. Upon successful installation you
should see something like this in the Windows Services via the Administration Tool:

Uninstalling Move on Windows

Please use the Control Panel to uninstall Move.

Uninstalling Licensing Service on Windows

Upon successful installation you should see something like this in the Windows Services via the
Administration Tool.

You can remove the Windows Service using the above tool.

Alternatively you can remove the FLEXnet service via a Command Console:

C:\ sc delete "FLEXnet Licensing Service 64"

2018.1.1 Installation Guide
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Using Windows Remote Desktop

When connecting to a remote system using Microsoft’s Remote Desktop Services youmay experience
issues when using largermodels. This is due to limitations with the software OpenGL driver that is used when
using the remote connection. There are several ways to work around such issues:

Use another remote display application that uses the hardware capabilities of the host machine.

Start Move on the host machine BEFORE connecting to it. This requires physical access to the host system.

Use the alternate software OpenGL drivers provided with Move. These are located in the bin/mesa3d folder
inside the location where Move was installed. When Move senses that it is running remotely then it will
prompt the user that the software drivers are being copied into the bin folder and being utilised.

3D PDF Animations

Onmachines without Adobe Flash Player installed, the 2D animation controls in the 3D PDF output fail to
function. Flash is NOT required for viewing the 3D content files, only the 2D Section Animations. Install Flash
Player software to resolve this issue.

The Acrobat Player errormessage links to here:

https://helpx.adobe.com/acrobat/using/flash-player-needed-acrobat-reader.html

Installing on Linux

We recommend you should have root permission or be the root user on Linux to install.

Installing Move on Linux is a straight forward process of extracting the software from the archive and running
a script which will prompt for required input at the appropriate time.

The software can be installed anywhere, the following instructions assume it will be installed in /opt/MVE.

Extracting the software

Move is bundled in compressed tar archive. To extract the software, follow these steps:

1. Go to destination directory:

prompt# cd /opt

prompt# mkdir -p MVE

prompt# cd MVE

2. Copy tgz file:

prompt# cp USB_Drive/Move2018.1/Linux64/move_2018.1.1_linux_64-bit.tgz .

3. Extract archive: 

prompt# tar zxf move_2018.1.1_linux_64-bit.tgz

This will create a Move2018.1 folder containing the software.

2018.1.1 Installation Guide



9

Running the setup scripts

You now need to run the setup script which will complete the installation process.

1. Go to the license directory:

prompt# cd /opt/MVE/Move2018.1/license

2. Run FLEXnet License Service set-up script:

prompt# ./install_fnp.sh

3. Go to bin directory:

prompt# cd /opt/MVE/Move2018.1/bin

4. Run Move set-up script:

prompt# ./setup.sh

Do you wish to install Move in '/opt/MVE/Move2018.1/bin' [Y/n]?

Do accept the terms of the license agreement [Y/n/v]?

5. As shown above, you will be prompted for various information. The default answer is shown in upper
case; press Return to accept it. Otherwise, type y orn and clickReturn to accept it. You will be
asked to:

l Confirm location
l Accept the license agreement (pressing vwill display the license agreement).

6. Once the setup script completes, it will display the installation log containing any errors, saved in:

/opt/MVE/Move2018.1/bin/install.log

7. To start Move, please use the ‘move’ script generated during the installation (do not run the Move
application directly).

prompt# /opt/MVE/Move2018.1/bin/move

License Manager Components

The process outlined above will install a FLEXnet License Manager Service as part of the pre-install process –
using the setup_fnp.sh script. This service MUST be installed. If you wish to run Move from a network
location, or script a customMove set-up, then please contact Midland Valley for further instructions.

Uninstalling Move on Linux

Remove the entire installation directory using the following command:

prompt# /bin/rm -rf /opt/MVE/Move2018.1
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Uninstalling Licensing Service on Linux

Remove the entire installation directory using the following command:

prompt# /bin/rm –rf /usr/local/share/FNP/service64/11.14.0

Installing Move via Mass Deployment Tools

When installing Move2018.1 via a deployment tool such as SCCM the following commands can be used to
silently install Move removing the requirement for local user interaction.

C:\> install.exe /SILENT

C:\> install.exe /VERYSILENT

C:\> install.exe /VERYSILENT /COMPONENTS=”main”

Use /SILENT or /VERYSILENT Options When Scripting.

/SILENT, /VERYSILENT

Instructs Setup to be silent or very silent. When Setup is silent the wizard and the background window are
not displayed but the installation progress window is. When a setup is very silent this installation progress
window is not displayed. Everything else is normal so for example errormessages during installation are
displayed and the startup prompt is (if you haven't disabled it with DisableStartupPrompt or the '/SP-'
command line option explained above).

If a restart is necessary and the '/NORESTART' command isn't used (see below) and Setup is silent, it will
display a Reboot now? message box. If it's very silent it will reboot without requiring permission.

/SUPPRESSMSGBOXES

Instructs Setup to suppress message boxes. Only effective when combined with '/SILENT' and
'/VERYSILENT'.

The default response in situations where a choice offered is:

l Yes in a 'Keep newer file?' situation.
l No in a 'File exists, confirm overwrite.' situation.
l Abort in Abort/Retry situations.
l Cancel in Retry/Cancel situations.
l Yes (=continue) in a
DiskSpaceWarning/DirExists/DirDoesntExist/NoUninstallWarning/ExitSetupMessage/ConfirmUninsta
ll situation.

l Yes (=restart) in a FinishedRestartMessage/UninstalledAndNeedsRestart situation.

5 message boxes are not suppressible:

l The About Setup message box.
l The Exit Setup? message box.
l The FileNotInDir2 message box displayed when Setup requires a new disk to be inserted and the disk
was not found.

2018.1.1 Installation Guide
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l Any (error) message box displayed before Setup (or Uninstall) could read the command line
parameters.

l Anymessage box displayed by [Code] support function MsgBox.

Use Environment Variable (use MVELD_LICENSE_FILE)

Set from user/machine Windows registry or from the system/domain environment. Registry:

HKEY_CURRENT_USER\Software\FLEXlm License Manager\MVELD_LICENSE_FILE

Set this variable value to point to the license server. eg @hostname or port@hostname.

The port number is optional when the license server is running on default 27000 to 27XXX.

By default Move will look to the environment first for a license, removing the requirement for this to be set-up
individually.

2018.1.1 Installation Guide
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MOVE LINK FOR PETREL V2018.1

The Move Link for Petrel* provides a means for Petrel users to share and transfer data with Midland Valley's
Move product.

Once installed, the Link allows the Petrel user to specify objects within the input tree to send across to Move.
Once in Move, it is then possible to performmodel building, editing and analysis or utilise functionality within
the modelling modules to perform restoration, validation, balancing, Fault Analysis, Stress Analysis,
Geomechanical Modelling, Fracture Modelling and Fault Response Modelling on the transferred objects (if
licenses for these modules have been purchased and are available).

*Mark of Schlumberger

System Requirements

Software

To use the Move Link for Petrel (version 2018.1), users are required to have a valid licence of:

l Midland Valley’s Move application 2018.1 (Move2018.1)
l Schlumberger’s Petrel seismic to simulation software version 2017.x, 2016.x, or 2015.x
l Move Link for Petrel version 2018.1 fromMidland Valley. For clarification on compatibility please email
support@mve.com.

Operating System

Petrel is a Windows only product and therefore the Move Link for Petrel will only be available where all
products are running onWindows. See the Move system requirements and the Petrel software system
requirements for details.

Installation

Move Link for Petrel can be either be installed using the Ocean Plugin Manager, or directly using the provided
msi installer package files.

To install using the Plugin manager.

l Access the Ocean Plugin Manager... (when using the ribbon interface this is accessed via the File ->
Options menu, and in the Classic User interface via the Help menu)

l Select Install plugin.
l Browse to the appropriate pip fie on the installation disk( see table below ).
l Close down Petrel.
l When Petrel is restarted, the Move Link icon will be visible (If using the ribbon interface, this will be in a
newMVE group in the Home tab, and when using the classic interface, as a tool button in the File
Actions toolbar.

It is recommended that the plugin is installed using administrator privileges.

Move Version Petrel Version Move Link for Petrel Version (via pip or msi)

Move2018.1 (64-bit) 2017.x (64-bit) MoveLink2018forPetrel2017.pip

Move2018.1 (64-bit) 2016.x (64-bit) MoveLink2018forPetrel2016.pip

Move2018.1 (64-bit) 2015.x (64-bit) MoveLink2018forPetrel2015.pip

2018.1.1 Installation Guide
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MOVE LINK FOR OPENWORKS R5000

The Move Link for OpenWorks R5000 provides a means for LandmarkOpenWorks users to share and transfer
data with Midland Valley's Move Application of the Move Suite.

The Link allows the Move user to directly import objects within an OpenWorks R5000 database via the input
tree to send them across to Move. Once in Move, it is then possible to performmodel building, editing and
analysis or utilise functionality within the modelling modules to perform restoration, validation, balancing,
Geomechanical Modelling, Fracture Modelling and Sediment Modelling on the transferred objects (if licenses
for these modules have been purchased and are available).

Software

To use the Move Link for OpenWorks R5000, users are required to have a licence of:

l Move Link for OpenWorks R5000 software fromMidland Valley.
l Move software from version Move2018.1 fromMidland Valley.
l Linux - LandmarkOpenWorks software from version 5000.10.3 back.
l Windows - LandmarkOpenWorks software from version 5000.10.3 back.
l Oracle software version 11g onwards.

For clarification on compatibility please email: support@mve.com.

Operating System

Please check to ensure you have at least the minimum specification before installing:

Windows Microsoft WindowsWindows 7 (64-bit).

Linux Linux Red Hat Enterprise 6 (64-bit).

Installation (client)

The Linkwill workwhether running Move from the same machine as OpenWorks is installed on or
alternatively from a client machine on the network that can see the OpenWorks and Oracle installations.

LinuxMove clients should ensure that Oracle and OpenWorks installations are on your PATH and LD_
LIBRARY_PATH and visible on the network. Optionally on Linux you can install a local client of Oracle
software.

Windows clients MUST install Oracle client and OpenWorks client software before you run Move. See the
installation guides from these products formore information. Midland Valley do not supply Oracle or
LandmarkOpenWorks clients; these can be obtained as part of your own OpenWorks installation - contact
your own local OpenWorks administrator. Some environment variables that need to be set or will help set-up
include:

l OWHOME, OW_ORACLE_USER OW_HOME_DIR

2018.1.1 Installation Guide
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INSTALLING MOVE KNOWLEDGE BASE

Windows and Linux have different installation instructions. Please refer to the appropriate section below.

Installing on Windows

It is recommend that you should be a power/administrator user onWindows to install or with UAC elevated to
administrator to install on Windows Vista and Windows 7.

To begin the installation process youmust browse to the installer file, for example:

USB-Drive:\Move2018.1\Windows64\Move_Knowledge_Base_2018.1.1_windows_64-bit.exe

License Agreement

To continue with installation please accept the terms of the agreement and clickNext.

Installation Folder

Select the folder in which you wish to install the Move Knowledge Base. Youmay select your own location by
clicking Choose or by typing the explicit location in the input box. The recommended location is:

C:\Program Files\Midland Valley\Move2018.1 Knowledge Base

Uninstalling Move Knowledge Base on Windows

Please use the Control Panel to uninstall the Move Knowledge Base.

2018.1.1 Installation Guide
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Installing on Linux

We recommend you should have root permission or be the root user on Linux to install.

Installing the Move Knowledge Base on Linux is a straight forward process of extracting the software from
the archive and running a script which will prompt for required input at the appropriate time.

The software can be installed anywhere, the following instructions assume it will be installed in /opt/MVE. If
the /opt/MVE directory has been created when installing Move2018.1then the creation of the MVE directory
in step 1 for extracting the software should be skipped.

Extracting the software

Move is bundled in compressed tar archive. To extract the software, follow these steps:

1. Go to destination directory:

prompt# cd /opt

prompt# mkdir -p MVE

prompt# cd MVE

2. Copy tgz file:

prompt# cp USB_Drive/Move2018.1/Linux64/Move_Knowledge_Base_2018.1.1_linux_64-bit.tgz
.

3. Extract archive: 

prompt# tar zxf Move_Knowledge_Base_2018.1.1_linux_64-bit.tgz

Running the setup scripts

1. Go to bin directory:

prompt# cd "/opt/MVE/Move2018.1 Knowledge Base/bin"

2. Run Move Knowledge Base set-up script: 

prompt# ./setup.sh

Do you wish to install Move Knowledge Base in "/opt/MVE/Move2018.1 Knowledge
Base/bin" [Y/n]?

Do accept the terms of the license agreement [Y/n/v]?

3. As shown above, you will be prompted for various information. The default answer is shown in upper
case; press Return to accept it. Otherwise, type y orn and clickReturn to accept it. You will be
prompted to:

l Confirm the install location.
l Accept the license agreement (pressing vwill display the license agreement).

4. Once the setup script completes, it will display the installation log, saved in:

"/opt/MVE/Move2018.1 Knowledge Base/bin/install.log"
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Any errors will be saved in that file.

5. To start the Move Knowledge Base, please use the ‘movekb’ script generated during the installation
(do not run the Move Knowledge Baseapplication directly).

prompt# "/opt/MVE/Move2018.1 Knowledge Base/bin/movekb"

Uninstalling Move Knowledge Base on Linux

Remove the entire installation directory using the following command:

prompt# /bin/rm -rf "/opt/MVE/Move2018.1 Knowledge Base"

2018.1.1 Installation Guide
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CONTACTING MIDLAND VALLEY

Midland Valley is a Petroleum Experts Ltd. company

Contact Details

Midland Valley
2West Regent Street
GlasgowG2 1RW, UK

www.mve.com

T: +44 (0) 141 332 2681
F: +44 (0) 141 332 6792

Petroleum Experts Ltd.
Petex House, 10 Logie Mill
Edinburgh, EH7 4HG, UK

www.mve.com/petex

T: +44 (0) 131 474 7030
F: +44 (0) 131 474 7031

Support Email address

Licensing & Technical support@mve.com

Geological help@mve.com

Additional Licenses sales@mve.com
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